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1.What is the AT command.

AT command is used for controlling module. You can use AT command to configure and query the settings.

2.How to use the AT command

For USR device is in transparent mode normally, you must enter AT command mode at first. Then you can
send AT command to configure or query the settings. After you configure the USR device, you should restart
the USR device to make the settings take effect. Every time module restart will work in work mode rather AT
command mode.
Every AT command must add character carriage return <CR> and line feed <LF>. In Hex, <CR> is 0x0D
<LF> is 0x0A.

2.1.How to enter AT command mode

Please read this FAQ about entering AT command mode.
http://www.usriot.com/enter-serial-command-mode/

3. AT command set

Command Function
E Set AT command echo enable/disable

ENTM Exit serial AT command mode and enter work mode
NETP Query/Set Network protocol parameters of socket A
UART Query/Set serial port parameters
UARTF Query/Set Serial package function enable/disable
UARTFT Query/Set Serial package triggering time
UARTFL Query/Set Serial package triggering length
TMODE Query/Set module work mode
WMODE Query/Se mode of WIFI(AP/STA)
WSKEY Query/Set encryption parameters in STA mode
WSSSID Query/Set SSID of connected AP
WSLK Query the connection status in STA mode
WEBU Query/Set web server username and password
WAP Query/Set AP mode parameters
WAKEY Query/Set encryption parameters in AP mode
MSLP Query/Set Sleep mode enable/disable
WSCAN Search surrounding AP

http://www.usriot.com/enter-serial-command-mode/
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TCPLK Query socket A TCP connection connect/disconnected

TCPDIS
Query/Set establish TCP connection enable/disable(Only take effect in TCP Client
mode)

WANN Query/Set network parameters in STA mode
LANN Query/Set network parameters in AP mode

DHCPGW Query/Set DHCP gateway address
TCPTO Query/Set timeout re-connection function time of socket A
MAXSK Query/Set maximum TCP Clients in TCP Server work mode
TCPB Query/Set Socket B enable/disable
TCPPTB Query/Set Socket B port number
TCPADDB Query/Set Socket B server address
TCPTOB Query/Set timeout re-connection function time of socket B
TCPLKB Query socket B TCP connection connect/disconnected
EPHYA Set Ethernet interface 1 enable/disable
EPHYB Set Ethernet interface 2 enable/disable
RELD Restore user default setting
FUDLX Set RS485 enable/disable
MMID Set module ID

IDFIR
Set sending two bytes ID and two bytes ID inverse code after firstly establishing
connection enable/disable

IDEVE
Set sending two bytes ID and two bytes ID inverse code before every data
enable/disable

AABR Set baud rate synchronization function enable/disable
DHCPDEN Set DHCP Server function of LAN port enable/disable
HIDESSID Set hiding SSID of module in AP mode function enable/disable
DOMAIN Query/Set web server domain name

Z Reset the module
MID Query module ID
VER Query firmware version
H Query help information of commands

WSSSIDA Query/Set first AP SSID in STA mode
WSSSIDB Query/Set second AP SSID in STA mode
WSSSIDC Query/Set third AP SSID in STA mode
WSKEYA Query/Set first AP encryption parameters in STA mode
WSKEYB Query/Set second AP encryption parameters in STA mode
WSKEYC Query/Set third AP encryption parameters in STA mode
WSQY Query/Set RSSI threshold(percentage) to switch among three AP in STA mode

HTPMODE Query/Set HTTPD Client mode parameters configuring way(new/old)

HTTPURL
Query/Set HTTP Server address and port in HTTPD Client mode old configuring
way

http://www.usriot.com/
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HTTPTP Query/Set HTTP requesting method in HTTPD Client mode old configuring way
HTTPPH Query/Set HTTP header path in HTTPD Client mode old configuring way
HTTPCN Query/Set HTTP header connection in HTTPD Client mode old configuring way
HTTPUA Query/Set HTTP header User-Agent in HTTPD Client mode old configuring way

HTPSV
Query/Set HTTP Server Address and Port in HTTPD Client mode new configuring
way

HTPTP Query/Set HTTP requesting method in HTTPD Client mode new configuring way
HTPURL Query/Set HTTP URL in HTTPD Client mode new configuring way
HTPHEAD Query/Set HTTP header in HTTPD Client mode new configuring way
REGEN Query/Set identity packet type
REGTCP Query/Set identity packet sending method
REGID Query/Set identity packet ID
IPBUP Query/Set domain name resolution IP backup function enable/disable
STAPRO Query/Set smart STA function enable/disable

4.AT command details
Special Characters

Character Note Hex

<CR> Carriage Return 0x0D

<LF> Line Feed 0x0A

4.1.AT+E
Format

Set AT+E<CR>
Return <CR><LF>+ok<CR><LF>

Note: Default setting of echo function is on, user can send above command to close, then send above
command again to open.

4.2.AT+ENTM
Format

Set AT+ENTM<CR>
Return <CR><LF>+ok<CR><LF>

http://www.usriot.com/
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4.3.AT+NETP
Parameter Description Default Value Range
<Protocol> Network protocol of Socket A TCP TCP/UDP

<CS> Network mode of Socket A Server Server/Client
<Port> Port number of Socket A 8899 Less than 65535

<Address>
Remote Server address of
Socket A in client mode

10.10.100.100
0.0.0.0~255.255.255.255

Domain name
Format

Query AT+NETP<CR>
Return <CR><LF>+ok=<Protocol>,<CS>,<Port>,<Address><CR><LF>
Set AT+NETP=<Protocol>,<CS>,<Port>,<Address><CR>

Return <CR><LF>+ok<CR><LF>

Note: When Socket A work in TCP Server or UDP Server, port can’t be 80(HTTP port), 8000(websocket port),
49000(usr-link port).

4.4.AT+UART
Parameter Description Default Value Range

<Baud
rate>

Baud rate 57600
300, 600, 1200,1800, 2400, 4800, 9600,
19200, 38400, 57600, 115200, 230400,

345600, 460800
<Data bits> Data bits 8 5, 6, 7, 8
<Stop bits> Stop bits 1 1,2
<Parity> Parity NONE NONE, EVEN, ODD, MARK, SPACE
<Flow

Control>
Flow Control NFC

NFC: No flow control
FC: Hardware flow control(RTS/CTS)

Format
Query AT+UART<CR>

Return
<CR><LF>+ok=<Baud rate>,<Data bits>,<Stop bits>,<Parity><Flow

Control><CR><LF>

Set
AT+UART=<Baud rate>,<Data bits>,<Stop bits>,<Parity><Flow

Control><CR>
Return <CR><LF>+ok<CR><LF>

4.5.AT+UARTF
Parameter Description Default Value Range
<Status> Status of Serial package function disable enable/disable

http://www.usriot.com/
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Format
Query AT+UARTF<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+UARTF=<Status><CR>

Return <CR><LF>+ok<CR><LF>

4.6.AT+UARTFT
Parameter Description Default Value Range
<Time> Serial package triggering time 500ms 100~10000ms

Format
Query AT+UARTFT<CR>
Return <CR><LF>+ok=<Time><CR><LF>
Set AT+UARTFT=<Time><CR>

Return <CR><LF>+ok<CR><LF>

4.7.AT+UARTFL
Parameter Description Default Value Range
<Length> Serial package triggering length 512 bytes 16~4096 bytes

Format
Query AT+UARTFL<CR>
Return <CR><LF>+ok=<Length><CR><LF>
Set AT+UARTFL=<Length><CR>

Return <CR><LF>+ok<CR><LF>

4.8.AT+TMODE
Parameter Description Default Value Range

<Mode>
Module data
transmissio
n mode

Through

Through: Transparent Transmission
mode

Agreement: Serial port command mode
GPIO: GPIO mode

Httpdclient: HTTPD Client mode
Modbus: Modbus TCP <=>Modbus RTU

mode
Format

Query AT+TMODE<CR>
Return <CR><LF>+ok=<Mode><CR><LF>
Set AT+TMODE=<Mode><CR>

Return <CR><LF>+ok<CR><LF>

http://www.usriot.com/
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4.9.AT+WMODE
Parameter Description Default Value Range
<Mode> WIFI mode of module AP AP/STA

Format
Query AT+WMODE<CR>
Return <CR><LF>+ok=<Mode><CR><LF>
Set AT+WMODE=<Mode><CR>

Return <CR><LF>+ok<CR><LF>

4.10.AT+WSKEY
Parameter Description Default Value Range

<AUTH>
Authentication

mode
OPEN

OPEN
WPAPSK
WPA2PSK
SHARED

<Encryption>
Encryption
algorithm

NONE

NONE: Take effect in <AUTH>=OPEN
TKIP/AES: Take effect in

<AUTH>=WPAPSK or WPA2PSK
WEP-A/WEP-H: Take effect in

<AUTH>=SHARED or OPEN(H means
HEX, A means ASCII)

<Password> Password
No default
value

<AUTH>= WPAPSK/WPA2PSK:
ASCII format, 8~63 bytes

<Encryption>=WEP-A: ASCII format,
5 or 13 bytes

<Encryption>=WEP-H: HEX format,
10 or 26 bytes

Format
Query AT+WSKEY<CR>
Return <CR><LF>+ok=<AUTH>,<Encryption>,<Password><CR><LF>
Set AT+WSKEY=<AUTH>,<Encryption>,<Password><CR>

Return <CR><LF>+ok<CR><LF>

4.11.AT+WSSSID
Parameter Description Range
<SSID> SSID of connected AP Less than 32 bytes

http://www.usriot.com/
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Format
Query AT+WSSSID<CR>
Return <CR><LF>+ok=<SSID><CR><LF>
Set AT+WSSSID=<SSID><CR>

Return <CR><LF>+ok<CR><LF>

4.12.AT+WSLK
Parameter Description Range

<Status>
Connection

status of module
in STA mode

Disconnected: No connection with any AP
SSID of connected AP if connected

RF Off: Close WIFI
Format

Query AT+WSLK<CR>
Return <CR><LF>+ok=<Status><CR><LF>

4.13.AT+WEBU
Parameter Description Default Value Range
<Username> Username of web server admin Less than 16 bytes
<Password> Password of web server admin Less than 16 bytes

Format
Query AT+WEBU<CR>
Return <CR><LF>+ok=<Username>,<Password><CR><LF>
Set AT+WEBU=<Username>,<Password><CR>

Return <CR><LF>+ok<CR><LF>

4.14.AT+WAP
Parameter Description Default Value Range
<Mode> WIFI mode 11BGN 11B/11BG/11BGN/11G/11N
<SSID> SSID in AP mode Less than 32 bytes

<Channel> WIFI channel Auto Auto/CH1~CH11
Format

Query AT+WAP<CR>
Return <CR><LF>+ok=<Mode>,<SSID>,<Channel><CR><LF>
Set AT+WAP=<Mode>,<SSID>,<Channel><CR>

Return <CR><LF>+ok<CR><LF>

http://www.usriot.com/
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4.15.AT+WAKEY
Parameter Description Default Value Range

<AUTH>
Authentication

mode
OPEN

OPEN
SHARED
WPAPSK
WPA2PSK

<Encryption>
Encryption
algorithm

NONE

NONE: Take effect in <AUTH>=OPEN
WEP-A/WEP-H: Take effect in

<AUTH>=SHARED or OPEN(H means
HEX, A means ASCII)

TKIP/AES/TKIPAES: Take effect in
<AUTH>= WPAPSK/WPA2PSK

<Password> Password
No default
value

<AUTH>= WPAPSK/WPA2PSK: ASCII
format, 8~63 bytes

<Encryption>=WEP-A: ASCII format,
5 or 13 bytes

<Encryption>=WEP-H: HEX format,
10 or 26 bytes

Format
Query AT+WAKEY<CR>
Return <CR><LF>+ok=<AUTH>,<Encryption>,<Password><CR><LF>
Set AT+WAKEY=<AUTH>,<Encryption>,<Password><CR>

Return <CR><LF>+ok<CR><LF>

4.16.AT+MSLP
Parameter Description Default Value Range

<Status> Status of sleep mode ON
ON: Exit sleep mode

OFF: Enter sleep mode
Format

Query AT+MSLP<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+MSLP=<Status><CR>

Return <CR><LF>+ok<CR><LF>

Note: When module enter sleep mode and user send AT+MSLP=ON to exit sleep mode, module will enter AT
command mode.

http://www.usriot.com/
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4.17.AT+WSCAN
Parameter Description
<RSSI> RSSI of AP that be searched by module
<SSID> AP’s SSID that be searched by module
<BSSID> MAC address of AP that be searched by module
<Channel> WIFI network channel

<Encryption> Encryption algorithm of AP that searched by module
<Authenticati

on>
Authentication mode of AP that searched by module

Format
Query AT+WSCAN<CR>

Return

<CR><LF>+ok=<LF><CR>RSSI,SSID,BSSID,Channel,Encryption,Authent
ication<LF><CR><RSSI1><SSID1>,<BSSID1>,<Channel1>,<Encryption1
>,<Authentication1><LF><CR><RSSI2><SSID2>,<BSSID2>,<Channel2>,
<Encryption2>,<Authentication2><LF><CR>.....<LF><CR><RSSIN><SSID
N>,<BSSIDN>,<ChannelN>,<EncryptionN>,<AuthenticationN><CR><LF>

4.18.AT+TCPLK

Parameter Description Range

<Status>
Status of TCP connection of

Socket A
on: TCP connection connected

off: TCP connection disconnected
Format

Query AT+TCPLK<CR>
Return <CR><LF>+ok=<Status><CR><LF>

4.19.AT+TCPDIS
Parameter Description Default Value Range

<Status>

Allowing
establishing

TCP
connection in
TCP Client

mode

on

on: Allow connecting, after setting to
on, starting to connect to server
immediately
off: Disallow connecting, after setting
to off, disconnecting immediately and
not to reconnect

Format
Query AT+TCPDIS<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+TCPDIS=<Status><CR>

Return <CR><LF>+ok<CR><LF>

http://www.usriot.com/
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4.20.AT+WANN
Parameter Description Default Value Range

<Mode>
How to get IP address in

STA mode
DHCP static/DHCP

<IP address> IP address in STA mode 0.0.0.0 0.0.0.0~255.255.255.255
<Mask> Subnet mask in STA mode 0.0.0.0 0.0.0.0~255.255.255.255

<Gateway>
Gateway address in STA

mode
0.0.0.0 0.0.0.0~255.255.255.255

Format
Query AT+WANN<CR>
Return <CR><LF>+ok=<Mode>,<IP address>,<Mask>,<Gateway><CR><LF>
Set AT+WANN=<Mode>,<IP address>,<Mask>,<Gateway><CR>

Return <CR><LF>+ok<CR><LF>

4.21.AT+LANN
Parameter Description Default Value Range

<IP address>
IP address of module in

AP mode
10.10.100.254 0.0.0.0~255.255.255.255

<Mask>
Subnet mask of module

in AP mode
255.255.255.0 0.0.0.0~255.255.255.255

Format
Query AT+LANN<CR>
Return <CR><LF>+ok=<IP address>,<Mask><CR><LF>
Set AT+LANN=<IP address>,<Mask><CR>

Return <CR><LF>+ok<CR><LF>

Note: WAN port IP and LAN port IP can’t in same network segment.

4.22.AT+DHCPGW
Parameter Description Default Value Range
<Address> DHCP gateway address 10.10.100.254 0.0.0.0~255.255.255.255

Format
Query AT+DHCPGW<CR>
Return <CR><LF>+ok=<Address><CR><LF>
Set AT+DHCPGW=<Address><CR>

Return <CR><LF>+ok<CR><LF>

http://www.usriot.com/
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4.23.AT+TCPTO
Parameter Description Default Value Range

<Time>
Timeout re-connection time

of socket A
0

0-600s
0 (Close function)

Format
Query AT+TCPTO<CR>
Return <CR><LF>+ok=<Time><CR><LF>
Set AT+TCPTO=<Time><CR>

Return <CR><LF>+ok<CR><LF>

4.24.AT+MAXSK
Parameter Description Default Value Range

<NUM>
Maximum TCP Clients that module

support in TCP Server
32 1~32

Format
Query AT+MAXSK<CR>
Return <CR><LF>+ok=<NUM><CR><LF>
Set AT+MAXSK=<NUM><CR>

Return <CR><LF>+ok<CR><LF>

4.25.AT+TCPB
Parameter Description Default Value Range
<Status> Status of socket B on on/off

Format
Query AT+TCPB<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+TCPB=<Status><CR>

Return <CR><LF>+ok<CR><LF>

4.26.AT+TCPPTB
Parameter Description Default Value Range
<Port> Port number of Socket B 18899 1~65535

Format
Query AT+TCPPTB<CR>
Return <CR><LF>+ok=<Port><CR><LF>
Set AT+TCPPTB=<Port><CR>

Return <CR><LF>+ok<CR><LF>

http://www.usriot.com/
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4.27.AT+TCPADDB
Parameter Description Default Value Range

<Address>
Remote Server

address of Socket B
10.10.100.100

0.0.0.0~255.255.255.255
Domain name

Format
Query AT+TCPADDB<CR>
Return <CR><LF>+ok=<Address><CR><LF>
Set AT+TCPADDB=<Address><CR>

Return <CR><LF>+ok<CR><LF>

4.28.AT+TCPTOB
Parameter Description Default Value Range

<Time>
Timeout re-connection

time of socket B
0

0-600s
0 (Close function)

Format
Query AT+TCPTOB<CR>
Return <CR><LF>+ok=<Time><CR><LF>
Set AT+TCPTOB=<Time><CR>

Return <CR><LF>+ok<CR><LF>

4.29.AT+TCPLKB

Parameter Description Range

<Status>
Status of TCP connection of

Socket B
on: TCP connection connected

off: TCP connection disconnected
Format

Query AT+TCPLKB<CR>
Return <CR><LF>+ok=<Status><CR><LF>

4.30.AT+EPHYA
Format

Set AT+EPHYA=on/off<CR>
Return <CR><LF>+ok<CR><LF>

Note: Default of Ethernet interface 1 is on.

http://www.usriot.com/
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4.31.AT+EPHYB
Format

Set AT+EPHYB=on/off<CR>
Return <CR><LF>+ok<CR><LF>

Note: Default of Ethernet interface 2 is on.

User can also use AT+FVEW=disable/enable to set Ethernet interface in LAN port(disable) or WAN
port(enable). This command will take effect after restoring default settings.

4.32.AT+RELD
Format

Set AT+RELD<CR>
Return <CR><LF>+ok=rebooting...<CR><LF>

4.33.AT+FUDLX
Parameter Description Range
<Status> Status of RS485 function on/off

Format
Set AT+FUDLX=<Status><CR>

Return <CR><LF>+ok<CR><LF>

Note: Default of RS485 is off and this command will take effect after restoring default settings.

4.34.AT+MMID
Parameter Description Range

<ID> Module ID 0~65535
Format

Query AT+MMID<CR>
Return <CR><LF>+ok=<ID><CR><LF>
Set AT+MMID=<ID><CR>

Return <CR><LF>+ok<CR><LF>

4.35.AT+IDFIR
Parameter Description Default Range

<Status>
Status of sending two bytes ID and two

bytes ID inverse code after firstly
establishing connection function

off on/off

http://www.usriot.com/
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Format
Query AT+IDFIR<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+IDFIR=<Status><CR>

Return <CR><LF>+ok<CR><LF>

4.36.AT+IDEVE
Parameter Description Default Range

<Status>
Status of sending two bytes ID and two bytes
ID inverse code before every data function

off on/off

Format
Query AT+IDEVE<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+IDEVE=<Status><CR>

Return <CR><LF>+ok<CR><LF>

4.37.AT+AABR
Parameter Description Default Range
<Status> Status of baud rate synchronization function on on/off

Format
Query AT+AABR<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+AABR=<Status><CR>

Return <CR><LF>+ok<CR><LF>

4.38.AT+DHCPDEN
Parameter Description Default Range
<Status> Status of LAN port DHCP Server function on on/off

Format
Query AT+DHCPDEN<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+DHCPDEN=<Status><CR>

Return <CR><LF>+ok<CR><LF>
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4.39.AT+HIDESSID
Parameter Description Default Range

<Status>
Status of hiding SSID of module in AP mode

function
off on/off

Format
Query AT+HIDESSID<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+HIDESSID=<Status><CR>

Return <CR><LF>+ok<CR><LF>

4.40.AT+DOMAIN
Parameter Description Default
<Name> Domain name to enter module web server USR-WIFI232-AP

Format
Query AT+DOMAIN<CR>
Return <CR><LF>+ok=<Name><CR><LF>
Set AT+DOMAIN=<Name><CR>

Return <CR><LF>+ok<CR><LF>

4.41.AT+Z
Format

Set AT+Z<CR>
Return <CR><LF>+ok<CR><LF>

4.42.AT+MID
Parameter Description

<MID>
Module MID, format: A11-yymmddnnnn. yymmdd means produced

date year/month/day. nnnn means production series number
Format

Query AT+MID<CR>
Return <CR><LF>+ok=<MID><CR><LF>
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4.43.AT+VER
Parameter Description
<VER> Firmware version of the module

Format
Query AT+VER<CR>
Return <CR><LF>+ok=<VER><CR><LF>

4.44.AT+H
Parameter Description
<Help> Command help information

Format
Query AT+H<CR>
Return <CR><LF>+ok=<Help><CR><LF>

4.45.AT+WSSSIDA
Parameter Description
<SSID> First AP SSID which module want to connect in STA mode

Format
Query AT+WSSSIDA<CR>
Return <CR><LF>+ok=<SSID><CR><LF>
Set AT+WSSSIDA=<SSID><CR>

Return <CR><LF>+ok<CR><LF>

4.46.AT+WSSSIDB
Parameter Description
<SSID> Second AP SSID which module want to connect in STA mode

Format
Query AT+WSSSIDB<CR>
Return <CR><LF>+ok=<SSID><CR><LF>
Set AT+WSSSIDB=<SSID><CR>

Return <CR><LF>+ok<CR><LF>
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4.47.AT+WSSSIDC
Parameter Description
<SSID> Third AP SSID which module want to connect in STA mode

Format
Query AT+WSSSIDC<CR>
Return <CR><LF>+ok=<SSID><CR><LF>
Set AT+WSSSIDC=<SSID><CR>

Return <CR><LF>+ok<CR><LF>

4.48.AT+WSKEYA
Parameter Description Range

<AUTH>
Authentication

mode

OPEN
WPAPSK
WPA2PSK
SHARED

<Encryption>
Encryption
algorithm

NONE: Take effect in <AUTH>=OPEN
TKIP/AES: Take effect in <AUTH>=WPAPSK or

WPA2PSK
WEP-A/WEP-H: Take effect in <AUTH>=OPEN or
<AUTH>=SHARED(H means HEX, A means ASCII)

<Password> Password

<AUTH>= WPAPSK/WPA2PSK: ASCII format, 8~63
bytes

<Encryption>=WEP-A: ASCII format, 5 or 13 bytes
<Encryption>=WEP-H: HEX format, 10 or 26 bytes

Format
Query AT+WSKEYA<CR>
Return <CR><LF>+ok=<AUTH>,<Encryption>,<Password><CR><LF>
Set AT+WSKEYA=<AUTH>,<Encryption>,<Password><CR>

Return <CR><LF>+ok<CR><LF>

Note: Above is first AP encryption parameters which module want to connect in STA mode.
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4.49.AT+WSKEYB
Parameter Description Range

<AUTH>
Authentication

mode

OPEN
WPAPSK
WPA2PSK
SHARED

<Encryption>
Encryption
algorithm

NONE: Take effect in <AUTH>=OPEN
TKIP/AES: Take effect in <AUTH>=WPAPSK or

WPA2PSK
WEP-A/WEP-H: Take effect in <AUTH>=OPEN or
<AUTH>=SHARED(H means HEX, A means ASCII)

<Password> Password

<AUTH>= WPAPSK/WPA2PSK: ASCII format, 8~63
bytes

<Encryption>=WEP-A: ASCII format, 5 or 13 bytes
<Encryption>=WEP-H: HEX format, 10 or 26 bytes

Format
Query AT+WSKEYB<CR>
Return <CR><LF>+ok=<AUTH>,<Encryption>,<Password><CR><LF>
Set AT+WSKEYB=<AUTH>,<Encryption>,<Password><CR>

Return <CR><LF>+ok<CR><LF>
Note: Above is second AP encryption parameters which module want to connect in STA mode.

4.50.AT+WSKEYC
Parameter Description Range

<AUTH>
Authentication

mode

OPEN
WPAPSK
WPA2PSK
SHARED

<Encryption>
Encryption
algorithm

NONE: Take effect in <AUTH>=OPEN
TKIP/AES: Take effect in <AUTH>=WPAPSK or

WPA2PSK
WEP-A/WEP-H: Take effect in <AUTH>=OPEN or
<AUTH>=SHARED(H means HEX, A means ASCII)

<Password> Password

<AUTH>= WPAPSK/WPA2PSK: ASCII format, 8~63
bytes

<Encryption>=WEP-A: ASCII format, 5 or 13 bytes
<Encryption>=WEP-H: HEX format, 10 or 26 bytes

Format
Query AT+WSKEYC<CR>
Return <CR><LF>+ok=<AUTH>,<Encryption>,<Password><CR><LF>
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Set AT+WSKEYC=<AUTH>,<Encryption>,<Password><CR>
Return <CR><LF>+ok<CR><LF>

Note: Above is third AP encryption parameters which module want to connect in STA mode.

4.51.AT+WSQY
Parameter Description Default Value Range

<Ret>
RSSI

threshold(percentage)
100

0~100. 100: Not to
automatically switch AP

Format
Query AT+WSQY<CR>
Return <CR><LF>+ok=<Ret><CR><LF>
Set AT+WSQY=<Ret><CR>

Return <CR><LF>+ok<CR><LF>

4.52.AT+HTPMODE
Parameter Description Default Value Range
<Type> HTTPD Client configuring mode new new/old

Format
Query AT+HTPMODE<CR>
Return <CR><LF>+ok=<Type><CR><LF>
Set AT+HTPMODE=<Type><CR>

Return <CR><LF>+ok<CR><LF>

4.53.AT+HTTPURL
Parameter Description Default Value Range

<Address> Server Address 10.10.100.200
IP address: 0.0.0.0~255.255.255.255

Server address: 1-64 BYTES
<Port> Server Port 80 0-65535

Format
Query AT+HTTPURL<CR>
Return <CR><LF>+ok=<Address>,<Port><CR><LF>
Set AT+HTTPURL=<Address>,<Port><CR>

Return <CR><LF>+ok<CR><LF>

4.54.AT+HTTPTP
Parameter Description Default Value Range

<Method>
HTTPD requesting

method
GET GET/PUT/POST
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Format
Query AT+HTTPTP<CR>
Return <CR><LF>+ok=<Method><CR><LF>
Set AT+HTTPTP=<Method><CR>

Return <CR><LF>+ok<CR><LF>

4.55.AT+HTTPPH
Parameter Description Default Value
<Path> HTTPD header path /abcd

Format
Query AT+HTTPPH<CR>
Return <CR><LF>+ok=<Path><CR><LF>
Set AT+HTTPPH=<Path><CR>

Return <CR><LF>+ok<CR><LF>

4.56.AT+HTTPCN
Parameter Description Default Value

<Connection> HTTPD header connection keep-alive
Format

Query AT+HTTPCN<CR>
Return <CR><LF>+ok=<Connection><CR><LF>
Set AT+HTTPCN=<Connection><CR>

Return <CR><LF>+ok<CR><LF>

4.57.AT+HTTPUA
Parameter Description Default Value

< User-Agent> HTTPD header User-Agent lwip1.3.2
Format

Query AT+HTTPUA<CR>
Return <CR><LF>+ok=< User-Agent><CR><LF>
Set AT+HTTPUA=< User-Agent><CR>

Return <CR><LF>+ok<CR><LF>
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4.58.AT+HTPSV
Parameter Description Default Value Range

<Address> Server Address 10.10.100.200
IP address: 0.0.0.0~255.255.255.255

Domain name: 1-64 BYTES
<Port> Server Port 80 0-65535

Format
Query AT+HTPSV<CR>
Return <CR><LF>+ok=<Address>,<Port><CR><LF>
Set AT+HTPSV=<Address>,<Port><CR>

Return <CR><LF>+ok<CR><LF>

4.59.AT+HTPTP
Parameter Description Default Value Range
<Method> HTTPD request method GET GET/PUT/POST

Format
Query AT+HTPTP<CR>
Return <CR><LF>+ok=<Method><CR><LF>
Set AT+HTPTP=<Method><CR>

Return <CR><LF>+ok<CR><LF>

4.60.AT+HTPURL
Parameter Description Default Value Range
<URL> HTTPD URL /abcd Length:1~64 bytes

Format
Query AT+HTPURL<CR>
Return <CR><LF>+ok=<URL><CR><LF>
Set AT+HTPURL=<URL><CR>

Return <CR><LF>+ok<CR><LF>

4.61.AT+HTPHEAD
Parameter Description Default Value Range

<Header>
HTTPD header

data

Content-type:text/html;c
harset=utf-8(User should
use <<CRLF>> to replace
carriage return and line

feed)

Length: 0~200 bytes
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Format
Query AT+HTPHEAD<CR>
Return <CR><LF>+ok=<Header><CR><LF>
Set AT+HTPHEAD=<Header><CR>

Return <CR><LF>+ok<CR><LF>

4.62.AT+REGEN
Parameter Description Default Value Range

<Status>
Status of
identity
packet

off

id: Use 2 bytes ID code and 2 bytes
ID inverse code as identity packet
mac: Use 6 bytes MAC address as
identity packet
off: Disable the identity packet
function

Format
Query AT+REGEN<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+REGEN=<Status><CR>

Return <CR><LF>+ok<CR><LF>

4.63.AT+REGTCP
Parameter Description Default Value Range

<Method>

Identity
packet
sending
method

first

first: Only sending Identity packet
before first packet after firstly
connecting to server
every: Sending Identity packet in
every packet.

Format
Query AT+REGTCP<CR>
Return <CR><LF>+ok=<Method><CR><LF>
Set AT+REGTCP=<Method><CR>

Return <CR><LF>+ok<CR><LF>

4.64.AT+REGID
Parameter Description Default Value Range

<ID> Identity packet ID 1111 0-65535
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Format
Query AT+REGID<CR>
Return <CR><LF>+ok=<ID><CR><LF>
Set AT+REGID=<ID><CR>

Return <CR><LF>+ok<CR><LF>

4.65.AT+IPBUP
Parameter Description Default Value Range

<Status A>
Status of domain name resolution IP

backup function of socket A
off on/off

<Status B>
Status of domain name resolution IP

backup function of socket B
off on/off

Format
Query AT+IPBUP<CR>
Return <CR><LF>+ok=<Status A>,<Status B><CR><LF>
Set AT+IPBUP=<Status A>,<Status B><CR>

Return <CR><LF>+ok<CR><LF>

4.66.AT+STAPRO
Parameter Description Default Value Range
<Status> Status of smart STA function off on/off

Format
Query AT+STAPRO<CR>
Return <CR><LF>+ok=<Status><CR><LF>
Set AT+STAPRO=<Status><CR>

Return <CR><LF>+ok<CR><LF>
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5.Contact

Company: Jinan USR IOT Technology Limited
Address: Floor 11, Building No.1, No.1166, Xinluo Street, Gaoxin District, Jinan city, Shandong province,
250101 China
Tel: 86-531-88826739
Web: www.usriot.com
Support: h.usriot.com
Email: sales@usr.cn

6.Disclaimer

This document provide the information of USR-WIFI232-D2 products, it hasn’t been granted any intellectual
property license by forbidding speak or other ways either explicitly or implicitly. Except the duty declared in
sales terms and conditions, we don’t take any other responsibilities. We don’t warrant the products sales and
use explicitly or implicitly, including particular purpose merchant-ability and marketability, the tort liability of
any other patent right, copyright, intellectual property right. We may modify specification and description at
any time without prior notice.

7.Update History

2017-10-10 V1.0.0 created based on firmware version 5.01D.24.
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